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1 Getting started

1.1 Contents

tpsDig version 2

The following Help Topics are available:

Introduction

Data file formats

Sample data files

How to use this program

Outlines 

Program limitations

Main window

Image tools window

Image enhancements window 

Specimen information window

Multimedia window 

Updates

Changes

Uninstalling this program

Glossary

For Help on Help, Press F1

1.2 Introduction

The  purpose  of  this  program  is  to  facilitate  the  statistical  analysis  of  landmark  data  in
morphometrics by making it easier to collect  and maintain landmark  data from digitized images.   Given
an initial file specifying the names of the files  containing the images of the specimens,  the program can
be used to mark the locations of the landmarks.  It  also allows one to capture outlines of structures  and
linear measurements.  The output file is  in the TPS format  that  can be used as  input  to other programs
in this series (e.g., tpsRelw, tpsSuper, tpsRegr, etc.).   The output  file is  a simple ASCII file that  can be
easily  converted  into  other  standard  formats  (some  common  operations  are  provided  by  the  tpsUtil
program).

The program can also acquire images directly from a TWAIN compatible camera or scanner or from
Microsoft multimedia compatible video files (*.AVI and *.MOV).  

Several standard image enhancement operations (such as  smoothing,  sharpening,  and  increasing
image  contrast)  can  also  be  applied  to  make  it  easier  to  locate  landmarks  on  the  images.   These
operations are available on the Image tools window.

The program can be used to compute lengths, angles, perimeters, and areas.  The profile mode can
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be used to compute a horizontal or vertical brightness profile across an image.

There  are  now both  32  bit  and  64  bit  versions  of  the  program.  The  latter  may  be  useful  when
processing very large datasets.

1.3 How to use this program

Normally, the first step is  to prepare an initial TPS file that  simply  provides a list  of the images to
be processed (the ID, COMMENT, and VARIABLES fields can also be included if desired).   This  can be
done using a simple ASCII editor such as  the Windows notepad program. The easiest  way to build this
initial file is  to use the tpsUtil  program. which has an option to automatically  build a tps  file  listing  the
names of all the image files in a specified directory.  If one has just two images the initial file test.tps

could be prepared as follows:

LM=0

IMAGE=canadn0c.tif

LM=0

IMAGE=canadn1c.tif

Note: by default only the names of the image files are stored rather than the full  file path.   Therefore,  the
image files must be stored in the same directory as the TPS file.  The “Include image path” menu option
will result in the full drive and path being stored in the file.  This latter option is  useful if,  for example,  the
images are stored on a CD.

The second step is  to  start  the  tpsDig  program  and  select  File|Source|File...  menu  items  and

select your TPS file in the Open dialog box.  The first image will  then be displayed in the main window. 
If the specimen does not fill the entire image you should consider cropping the image to reduce its  size

(and  hence  to  speed  up  its  processing).   Press   or  select  Options|Image  tools...  menu  items  to
display  the Image tools  window.  There are Select  and  IDH_Crop  buttons  on  the  Tools  page.   On  the
same page are also buttons for flipping the image from left to right and from top to bottom. There are also
button for several standard image enhancement operations. It  is  sometimes helpful to press the drawing

pen button, , and make small corrections in the image (especially useful when trying to find outlines
automatically). See the Draw page of the Image tools window to change the color and width of the pen.  If
the original images are BMP files  then  you  should  consider  converting  them  to  JPG  files  as  they  are
usually much smaller. This can be done with the tpsDig program by using the “Save image as” item on
the File menu.

Alternatively,  input  can  come  from  a  scanner  or  from  an  AVI or  MOV  file.   In  this  mode  one
acquires images one at a time, digitizes the landmarks,  and then saves the new image.  The TPS file is
then saved at the end of a session.  You can combine files  from different  sessions by  using the Append
TPS  files  item  from  the  Files  menu.   Note:  since  the  TPS  files  are  simple  ASCII  files  you  can  also
combine them using any ASCII editor.

The third step is to actually  digitize the landmarks,  semilandmarks,  or the outlines.  One can also
make  various  measurements  and  have  them  saved  to  the  listing  report  file  or  you  can  add  the
measurements can be added to the tps file as variables.

You  may  wish  to  zoom  the  image  in  or  out  to  see  more  detail  or  to  find  your  place  in  a  high-
resolution image.  This  can be done most  conveniently  by  enabling  the  mouse  wheel  for  zooming  (see
the Options menu). You can also  press the + or - zoom buttons on the toolbar to expand or contract the
image to a convenient size. In many cases it will  be most  convenient  to click  on the "Fit"  button (or the
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"Fit  to  window"  item  in  the  Options  menu)  so  the  image  fills  the  window.  Next,  select  the  button  for

digitizing landmarks ( ) and click  on the locations  of  each  landmark.  If  the  image  is  large  you  may
have to adjust  the size of the window or use the scroll  bars  so that  the  region  of  interest  is  visible  (or

else zoom it  until  it  fits).  If you make a mistake,  switch to edit  mode ( )  and  drag  the  landmarks  to
their correct locations.   In edit  mode you can delete a landmark,  curve,  or outline by  clicking on it  with
the right mouse button.  For low contrast gray images the standard cursor may sometimes be difficult  to
see. In the Image tools window you can select from among a number of alternative cursors. There is  also

a draw curves mode (press  or use the Modes menu) that  you can use to draw curves to make the
digitized data more recognizable (note:  these curves are not  intended for use in  computations).   Curve
points  can also be deleted by  clicking on them with the right  mouse button  while  in  edit  mode.  When
working with large image files  you may wish to experiment  with the landmark  and label size options in
the Image Tools window. Labels may not be very visible when the image is  zoomed out  so you can see
the entire image (as when the "Fit" option is selected).

If a  structure  of  known  length  is  visible  in  the  image,  one  can  select  the  "Set  scale"  mode  and
digitize the end points of the structure and enter the known length.  The computed scale factor is  stored
in the tps  file using the "SCALE=" keyword.   Note:  the coordinates  are always stored in the tps  file  in
pixel units that correspond to the image.

Once the  landmarks  and  curves  have  been  digitized  for  the  current  specimen,  click  on  the  right

arrow button ( ) to move to the image  for  the  next  specimen.  Alternatively,  you  can  press  the  right
cursor key or press the Alt-N keys.  If you made any changes to the image (such as  cropping or various
enhancements) you will be asked to provide a file name for the changed image.   The new file name will
be inserted in the TPS file so that the new image will be used in the future.

If template mode (a choice on the Options menu) has been selected then the landmarks from the
previous specimen will be copied onto the next image as long as it does not have any landmarks already
entered.   You can then drag the landmarks to their appropriate locations.   Note that  the  first  landmark
you  move  will  translate  the  locations  of  all  the  landmarks.   Subsequent  landmarks  can  be  moved
individually.  This  option was provided to minimize the chance of making the common error of digitizing
the landmarks out of order.  It is also expected that this mode will speed up the process of digitizing the
landmarks (especially when there are many landmarks and variation in shape is small).

Click  the   speed  button  to  compute  outlines  for  structures.  Outlines  of  structures  can  be
obtained automatically  if they can be separated from the rest  of the image by choosing  an  appropriate
brightness threshold value.   The default  is  a value of 128 (midway between black,  0,  and  white,  255).  
You can check this  by  viewing the thresholded image.  Right  click  on the image to bring up the  outline
pop-up  menu  (this  view is  also  available  from  the  Toolbox).  The  number  of  black  and  white  pixels  is
displayed in the status  panel along the bottom of the window. If the scale factor has been set  then the
area is  displayed in user units.   By  default,  the program assumes that  the  structure  is  light  against  a
dark background but this can be changed from the Toolbox.  The area of an enclosed region can also be
computed once its outline has been captured by  selecting “Enclosed area” from the pop-up menu.  Note
there  is  an  item  on  the  Options  menu  to  set  whether  outlines  are  to  be  captured  in  a  clockwise  or
counter clockwise direction.

Click  on  the  ruler  speed  button  to  make  linear  measurements.  These  will  be  in  pixels  unless  a
scale has been set.  A special cursor will  be displayed when in measurement  mode.  Click  on an  initial
point  and  then  the  end  point  of  the  measurement.  The  value  will  be  displayed  at  the  bottom  of  the
window.  If  you  then  right-click  on  the  image  a  pop-up  menu  will  allow  you  to  select  saving  the
measurement in the report listing file or else as a value in the variables  field.  A pop-up window will  show
a preview of what  is  to be stored.  You can edit  this  if you wish.  The angle measurement  speed  button
allows one to measure angles using three mouse clicks. The first  click  should be at  the end of one ray,
the second at the origin, and the third at the end of the second ray. Click on the “Refresh display” item in
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the Options menu to erase these measurement  objects  from the display  (you can also right-click  on an
object and select Delete from the menu).

You may click on the left arrow ( ) and go back and review (and correct in Edit  mode,  press )
previous specimens.  Alternatively,  you can press the left  cursor key or press the Alt-P keys.   Note:  in
template  mode  landmarks  will  not  be  copied  onto  a  new image  if  any  landmarks  have  already  been
recorded for that image.

When work  for this  session has been completed click  on the save button  to  save  your  work  to  a

TPS file (press ).  You can also use the Save data as menu to save the data in the NTS file format.  
Note that NTS files cannot be read back into the tpsDig program and they also do not  support  outlines,
curves, and comments.

There are additional features that may sometimes be useful. See the Using the curves tool topic  for
a convenient way to enter semilandmarks. See Paint mode and Profile mode. 

The program can be run from the command line with the file name given as  an argument.   You can
also  drop  an  input  file  onto  the  tpsDig  form  or  onto  the  tps  Icon  from  the  Windows  Explorer  but  the
program cannot be run in a batch mode.

There are now 32 bit  and 64 bit  versions of this  program. The latter  may  be  helpful  when  working
with many high resolution images.

On  some  computers  there  may  be  a  problem  when  the  program  attempts  to  save  configuration
information  in  an  INI  file.  You  can  add  the  -E  parameter  to  the  Windows  shortcut  icon  to  force  the
program to save the INI file in the same directory as the program itself.  Follow this  link  to see how to do
it.

1.4 Uninstalling this program

You  can  use  either  the  uninstall  icon  for  this  program  or  the  Windows  Add/Remove  icon  in  the
Control Panel.  Note:  if you have used  the  help  file  or  added  additional  files  to  the  examples  directory
then you will get a message saying that all of the files  could not  be removed.  In that  case you will  need
to manually delete the directory into which you installed this program.

To remove this program manually you need to delete the program and help files  located in whatever
directory you installed this program.



Using the program



9

tpsDIG2                                                                                                                                                                                                                                                                                                                        © 2004-16

Using the program

2 Using the program

2.1 Main window

This window displays the current image.  In addition, there is a toolbar and a menu.

The body of the window displays the current image (once it has been selected by  using the menu).
 The status panel at the bottom of this window shows the following information:

1. The current x,y coordinates and brightness value for the current position of the mouse on the
image.

2. The name of the current image file.

3. The total number of specimens in the file.

4. The number of landmarks that have currently been marked. In curve mode (using the pencil tool)
the current curve number and point number are displayed. Once one has more than two points
recorded for the current curve then the enclosed area will also be displayed here. Click on it to
save it to the listing window.

5. In template mode a code is given to indicate whether the first, second, or more landmarks have
been edited.

6. The scale factor (if any) for the current specimen.

The menu provides the following operations and options:

1. File (input source [file or scanner], go directly to a particular specimen in the file, save data
[TPS file format], clear data [erase all landmark and curve information], save image, save screen
[image plus any landmarks and curves], print image, and print screen [includes any landmarks
and curves]). You can also append another TPS file to the end of the current information in
memory. Note: files can also be loaded from the command line or by dragging and dropping onto
the main window. The “Clear data” item erases all of the data from the current tps file (you may
never need use this except option when practicing using the program).

2. Modes (digitize landmarks, draw curves, edit mode, outline mode, paint mode, measurement
mode, and profile mode).
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3. Edit (copy screen including and landmarks, outlines, etc.  or just the image to clipboard so you
can paste it into another program).

4. Options (label landmarks, template mode, specimen information, set scale factor, image tools).
The “Query save image?” option will (by default) allow you a chance to save any images that you
modify or capture directly from a scanner or a multimedia file. You can also turn this off which
might be convenient when working with multimedia files. There is an option (on by default) to
allow one to toggle between landmark and edit modes by simply right-clicking on the image in a
region where there are no landmarks, curves, or outlines. There is also an option to specify
whether outlines are to be captured in a clockwise or counter clockwise direction. Note that
setting this option does not change how previously captured outlines are stored. If the "Beep on
landmark added" is checked then the program will beep every time a landmark is added.

The zoom options allow one to zoom the image in or out, automatically zoom the image to fit
the window, retain the current zoom factor when changing to the next specimen (only works
when the automatic zoom is turned off).

5. Help (contents, search, about).

The toolbar provides convenient buttons for the most common operations. 

 

A description is given below. 

1. : previous specimen.  Displays the previous image (if there is one).

2. : next specimen.  Saves the current landmark information and displays the next image.
Note: if the image input is from a scanner then this will acquire the next image.  If input is from
an AVI or a MOV file then this will capture the next image from the Multimedia Input window.
Alternatively you can position the Multimedia input window manually and then click the right
arrow to capture the current frame.

3. : digitize landmarks mode.  Displays a cross-hair cursor that records a landmark when the
left mouse button is clicked.

4.     insert a missing landmark.  The count of landmarks will be increased each time this
button is clicked and a point corresponding to the missing landmark will be displayed at the
upper left corner.  Alternatively, in edit mode one can right-click on a landmark and indicate that
it is missing.

5. : draw curves mode.  Displays a pencil cursor that you can use to draw a connected line
segment each time the left mouse button is clicked. Press the right mouse button or click on
the Edit mode button on the toolbar to start a new curve.   See the Using the curves tool topic
for more information.  The area of the enclosed region is also computed.

6. : edit mode.  Displays an arrow cursor that can be used to adjust the positions of the
landmark and the curve points.  Press the left button and then drag the point to a new location. 
Right click to display a popup menu of choices.

7.  measure mode. Displays an arrow cursor that can be used to mark the ends of a linear
measurement. The value in pixels or user units is displayed at the bottom of the window. Right-
click on the image to save the measurement to the report listing file or to save it as a variable.

8.  angle measure mode. Use three mouse clicks to measure an angle in degrees. Right-click
on the image to save the measurement to the report listing file or to save it as a variable.

9. #: label landmarks (turns labeling on and off).
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10.  Automatically compute and outline around an object at a particular threshold. The enclosed
area and perimeter can also be computed.

11. :  A save dialog box will be displayed to allow you to save the currently accumulated data.

12. : Show image tools window. It provides many important options such as the color and size of
the landmark points and their labels, image enhancement operations, setting a measurement
scale, and others.

13.    zoom to fit the image to the current window. This may require one to set larger label
sizes unless the sizes are in screen coordinates rather than in image coordinates.

14.  “Paint” directly on image (e.g., to close gaps for the outline procedure). The Undo and Redo
items on the Edit menu can be used to erase mistakes.

15. : Zoom in to make image larger by 10% each time. The zoom factor is displayed (and can
also be edited directly, click out of the edit box to effect your changes).

16. : Zoom out to make image smaller by 10% each time. The zoom factor is displayed.

17.   This control displays the current zoom factor. One can also enter a value to directly
specify an amount of zoom. The fit to window mode should be turned off when you do this.

While one usually loads files  from the Files|Open menu,  you can also drag and drop files  from the
Windows Explorer anywhere in  this  main  window to  load  the  files.  Note  than  when  no  specimen  has
been loaded clicking on most of the buttons will have no effect.

2.2 Image tools window

This window displays a notebook dialog box with tabs corresponding to several pages of options.  

Description of the pages:

Colors tab: you can select the color and size of points used to indicate the landmarks, background
curves, and outlines. The "Size in window pixels" check box is to select whether the size units are in
pixels of the open window or the pixels of the original image. This should usually be checked when
using the zoom option on large images.  You can also control the color and size of the labels and the
color used for measurements.
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Tools tab: The buttons on the toolbar provide the following operations on the current image (note the
Undo & Redo buttons in case the “enhancement” makes the image worse):

1. Convert color image to black & white (gray-scale).  The red, green, and blue brightness values
are simply averaged.

2. Perform various image enhancement operation (the "Enhance" button). Some of the
"enhancements" can have rather strange effects. The window just shows a preview. The image
is not modified until you click on the "OK" button. Note: if the crop or resize operations are
selected from the enhancement window then any existing for that image will not be adjusted to
match the new dimensions so they should be used before landmarks are recorded for the
present specimen.

3. Convert an image to its negative (changes from a positive image to a negative and vice versa).

4. Perform image smoothing to remove any fine-scale noise in the image.  A 3x3 grid is used.  The
image will first be converted to Gray-scale if was not already.

5. It is often useful to crop an image to reduce its size to a selected region.  First click on the
"Select" button and then use the mouse to drag a rectangle around the desired region on the
screen. Then click on the "Crop" button.  Only the part of the image within the rectangle will be
saved if you answer “yes” to the confirming prompt (no changes are made if you click on the
“No” button). The positions of any landmarks within the selected region will be adjusted for the
current image dimensions.

6. Flip image left to right, i.e., reflect the image from left to right. Perform this operation before
landmarks or outlines are recorded.

7. Flip top to bottom, i.e., reflect the image from top to bottom. Perform this operation before
landmarks or outlines are recorded.
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Cursors tab: click on a radio button next to the cursor you would like to use to digitize.  Low contrast
gray images often require darker or lighter cursors.

Outlines tab: You can specify the threshold and whether the object is dark against a light
background or light against a dark background.  There are also buttons to allow you to view a
thresholded image and to refresh the display.
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Paint tab: This page allows one to change the pen width and color to be used when drawing directly
on the image.  This can be useful to close small gaps in the image so that outlines can be located
automatically. A sample line is shown so that you can judge the appropriate size and color to use.  
Note: the undo button can be used to correct an erroe but only the previous 9 changes can be
undone.

Measure tab: This page allows one to set a scale and to measure lengths and angles. One can also
specify the units (used only for labeling the output). Measurements can be added to the listing file or
else added as descriptive variables for each specimen (this information can be put into matrix form
using the tpsUtil program). To set a scale factor, enter the known length of a structure in the edit box
and then digitize the two endpoints of the structure.  Enter just the numerical value, do not enter the
units.  Press the OK button to accept the scale factor or the cancel button to ignore any changes you
may have made in the scale factor.  Subsequent images you digitize are assumed to have the same
scale factor unless you explicitly give them their own scale factors. Using this feature causes the
"SCALE=" keyword to be inserted in the output file. The scale factor is the entered length in user



15

tpsDIG2                                                                                                                                                                                                                                                                                                                        © 2004-16

Using the program

units divided by the measured length in pixels. It also scales the coordinates appropriately (by default
the coordinates are in pixel units).  The scale factor can also be recorded in the listing window. The
scale factor is taken into account in the computation of image areas, perimeters, and linear distance
measurements. It has no effect on the landmark coordinates – they remain in pixel units. 

Note: the units are just used for a label – they are not taken into account in any computations so the
same units should be used for all specimens (i.e., do not say that some are in mm and others in cm).
See the "Colors" tab to set the color of the lines used to make measurements. The default is black
and that may not be very visible on dark images.

For more information about image enhancement operations see, for example, Rohlf (1990).

2.3 Multimedia input window

This  window displays  frames from an AVI or MOV  file  and  transfers  selected  frames  to  the  main
tpsDig window.  
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The VCR type controls  enable one to move  forward  and  backward  through  a  file  to  select  the  desired
frame (the frame number will be displayed).  The progress bar shows the current position in the file.

 

The buttons above correspond to Play,  Pause,  Stop,  rewind to beginning,  backup  frames  (by  the  step
size),  advance frame  (by the step size), and move to the end of the file. The frame number displays  the
current frame number. The Skip by window allows one to choose the increment for advancing through the
file (may be useful when there are many frames).

Click  on the “Capture” button to transfer the current  image to the Main window.  Equivalently,  you
can click on the right arrow button in the main window to capture the currently  displayed frame.  Before
the  image  will  be  transferred  to  the  Main  window you  will  be  prompted  for  a  file  name  for  the  image
currently displayed in the main window if the “Query save image?” option is checked.

The name of  the  file  and  the  current  frame  number  will  be  stored  in  the  comments  field  when  a
frame is captured. This information will be saved with the TPS file.

 Note: make sure that  this  window is  fully  open and clear of any overlapping windows before you
click on the Capture button or else parts of these other windows may be included in the image.

2.4 Image enhancements window

This  window  provides  various  standard  image  enhancement  operations.  The  screenshot  below
shows the contrast/brightness page.  Move the sliders  to increase or  decrease  the  effect.  Click  on  the
“Lock preview” box to display the changes continuously. Click the “OK” button to accept  the change and
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close the window. If you would like to accept the change but  also try  additional operations then click  on
the button between the Original and Result windows.

 

The  other  tabs  provide  access  to  other  image  operations.  The  “User  filter”  page  has  several
predefined operations that can be tried. The edges and high pass operations are often useful to bring out
detail in an image. A low pass filter smoothes an image and may make the automatic  outline detection
more reliable.  One can also enter values directly  for the filter values.  These can then be saved to a file
and reloaded later.

The following shows an example of the rotate tab.
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Once you return to the main tpsDig window and try to move to the next specimen you will  be asked
whether you  wish  to  save  the  changed  image.  You  may  either  store  it  under  the  same  name  (which
deletes the original file) or else give it a new name.

Some of the enhancements  can  make  unexpected  changes  to  the  image.  They  are  not  actually
applied to the current image until you click on the "OK"  button.

2.5 Output listing window

 Information about  the input  file  will  be  automatically  written  to  this  window.  In  addition,  you  can
click on the status  panel that  shows the enclosed area and that  will  also be added to this  window. If a
scale factor is set then that information is also recorded in this window.
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The information in this window can be saved to a file, copied and pasted to another program, or printed.

2.6 Profile window

This  window displays  a brightness  profile  plot  for  the  currently  selected  horizontal  or  vertical  line
across the image in the main window. Tic marks are displayed horizontally  for every  10 pixels  along the
profile.  The brightness values range from 0 (black) at the bottom to the maximum observed in the profile.
 Tic marks are shown along the vertical axis for every  10 levels  of brightness.  The Options menu can be
used to set  the width of the band can be set  from 1 to 10  pixels.   This  operation  is  performed  on  the
original un-zoomed image.

This plot can be copied to the Windows clipboard as a bitmapped image or saved to disk as a BMP
file.

2.7 Specimen information window

This  window  displays  edit  controls  that  allow  you  to  provide  the  following  information  for  each
specimen: 
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· identification code (e.g., specimen number), 

· comment (whatever information you would like to add), and 

· variables (a list of numerical codes separated by commas that may be used later by other
software to sort the specimens into groups). While no particular format is enforced, the
intended format is “M1=2.543,A=6,S=0”.  Linear distance measurements can be
automatically added to this window (by selecting “save as variable” from the pop-up menu
obtained by right-clicking on the image after a measurement is made.

2.8 Outlines

tpsDig  can  be  used  to  automatically  compute  outlines  around  structures  that  are  either  dark
against a light background or light against a dark background.  There is a spin control in the Toolbox that
allows you to specify  the threshold.   The default  is  128 (where black  = 0  and  white  =  255).   The  view
button displays  the image distinguishing pixels  that  are above and below the  threshold  (the  number  of
pixels  above and below the threshold is  also displayed since that  is  sometimes useful to  measure  the
area of a complex object).

To find an outline,  first check the Toolbox options (light  vs.  dark  and the threshold)  to  make  sure
they are correct.   It  is  also often useful to  smooth  the  image  somewhat  (unless  you  are  interested  in
using the outline to compute its  fractal dimension).   One may also need to  make  small  corrections  to
the image so that  complete outlines can be found automatically.   This  can be done by clicking  on  the

pen icon,  ,  on the toolbar.   You can specify  the width and color on the Draw page  of  the  Toolbox.
You also have to consider whether to trace the  outlines  in  a  clockwise  or  counter  clockwise  direction
(see the “Clockwise outlines” item in the Options menu).  The  choice  does  not  usually  matter  but  you
must  be consistent  across all  specimens.  Note that  setting this  option only  affects  how future outlines
are captured. It does not change the storage of previously captured outlines.

Second, click on the Outline speed button  on the toolbar.   The cursor will  change to indicate
that  the program is  now operating in outlining mode.  Click  with the  left  mouse  button  on  or  slightly  to
the right  of the object  of interest.   The  program  will  then  search  to  the  left  to  find  the  left  side  of  the
object  and circle around the object  until  it  finds  its  starting point.   A message  will  be  displayed  in  the
status window indicating either the number of points in the outline or whether the search failed (either no
object was found to the left or the outline was too long).  By default, the outline will be drawn in yellow.

Third,  press  the  right  mouse  button  to  obtain  a  popup  menu  that  will  allow you  to  accept  (i.e.,
save) the outline in several formats. 

X,Y-coordinates: x,y coordinates of points will be stored. 

chain code: chain codes for points  around outline will  be stored.  The x,y  coordinate of the starting
point will also be recorded.

X,Y coordinates of radii: x,y coordinates  of the tips  of equiangular radii  will  be stored.  The radii are
computed from the centroid of the enclosed region.

Radii: lengths of equiangular radii will be stored. Points will be deleted from the outline if necessary
in order to make the lengths of the radii unique. The radii are computed from the centroid of the enclosed
region.

This  pop-up  menu  also  allows  the  computation  of  the  enclosed  area  and  the  perimeter  of  the
outline.

Except for chain codes,  you can specify  less  than the actual number of points  so that  all  outlines
will be recorded with the same number of points. On the Options menu one can specify  whether the new
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number of points  are to be  selected  based  just  on  counting  points  or  by  computing  the  length  of  the
outline. The results are usually similar but selecting based on outline length is probably more desireable.
You  can  also  discard  the  outline,  view  the  thresholded  image,  refresh  the  display,  or  compute  the
enclosed area.  The area of an enclosed region in pixels  or user scaled units  is  displayed in the status
bar along the bottom of the window.  Once you accept  an outline it  is  redrawn in red (you can  change
the default outline colors in the toolbox). 

You can compute any number of outlines for each image and store them in either format.  There will
be  no  warning  messages  about  inconsistencies  between  images.   You  must  enforce  whatever
restrictions are required by  software that  will  eventually  read the file.   The program  will  warn  you  if  the
numbers of landmarks (which can be zero) are not the same for all specimens.

Outlines can be deleted when in Edit  mode.   Right  click  the mouse while pointing to an outline to
popup a menu that will allow you to delete the outline.  A message will  be displayed in the status  panel
indicating which outline will be deleted.

Computing  outlines  will  introduce  additional  keywords  in  the  output  file.   In  the  TPS  file  the
"OUTLINES=" keyword will indicate the number of outlines and "POINTS=" or "CHAIN=" will  indicate the
number of points  in the outline that  follows.   The chain codes values are preceded by  a  line  giving  the
starting x and y coordinates for the outline. “RADII” and “RADIIXY” codes will be used to indicate outlines
stored as equiangular radii.

Note: one can also record the coordinates of points  around the outline of some structure by  hand using
the pencil tool. When using this tool the enclosed area is computed as one goes along. Note there is  an
option in the Options menu for complete vs. partial outlines.

Note: If one intends to use the method of sliding semilandmarks for the outline points  then one should
record the  points  using  the  landmark  or  the  curve  drawing  tool  rather  than  an  automatically  captured
outline. This is because one usually  just  needs to have just  a few well-spaced points  from only  parts  of
an outline and one  must  start  and  end  with  a  landmark.  One  can  use  the  tpsUtil  program  to  convert
these curve points  to landmark  points  for further processing.  One  can  also  use  the  tpsUtil  program  to
create a sliders  file to define which points  are landmarks or semilandmarks.  In the tps  file  they  are  all
just landmark points.

2.9 Using the curves tool

The curves tool  on the toolbar is  usually  used to insert  points  along the outline of a structure
by hand rather than automatically  using the outline tool.  It  displays  a pencil cursor that  you can use to
draw a  connected  line  segment  each  time  the  left  mouse  button  is  clicked.   Press  the  right  mouse
button, double-click, or click on the Edit mode button on the toolbar to start a new curve.

In edit mode, moving the cursor over the curve will select it and the number of points will  be displayed on
the status panel. If one right-clicks on the curve a context  menu will  be displayed that  will  allow one to:
delete the entire curve, delete a selected point  (if the cursor was on a curve point),  resample the curve,
switch back to digitize landmark mode, or just cancel the context menu. If Resample is  selected,  then a
window will be opened that  displays  the current  number of points  on the selected curve and allows one
to specify a new number. If the “By steps” option is selected then the new number must be less than the
existing number. Points will be deleted to achieve the desired number of points.  Usually  one will  wish to
use the “By length” option.  With  this  option  the  new number  of  points  can  be  less  than,  equal  to,  or
larger than the existing number of points.  The new points  will  be computed by  linear interpolation along
the  curve.  They  will  be  approximately  equally  spaced  (it  is  difficult  to  achieve  exact  equal  spacing
because deleting points  changes the length of the curve when the curve changes shape  as  a  result  of
the deletion of points). In both cases the minimum number of new points is two.
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Example of an image with points along a curve:

 

Resampling dialog:

 

Result of resampling based on the length of the curve:
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Once  three  or  more  points  have  been  defined  on  a  curve  its  enclosed  area  will  be  computed  and
displayed on the status panel at the bottom. This information can be saved to listing window by clicking
on this panel.

Note:  on  computers  with  overly  responsive  mice,  one  may  inadvertently  insert  multiple  points  with  a
single click of the mouse. Displaying the Resample menu will check and eliminate such duplicate points
from the selected curve.

Note: other software may not  recognize curve points  as  landmark  points.  The  tpsUtil  program  has  an
option to append curve points as landmarks in order after any existing landmarks.



Files
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3 Files

3.1 Data file formats

The TPS file format  (identified by  a file extension of "TPS") is  supported.   It  is  a  non-standard  file

format that allows not only  the x,y-coordinates  of the landmarks but  also outlines,  names of associated
image files, scale factor, and comment fields.  Points  can also be recorded along background curves to
outline the organism, The format is described below.  The NTS format is supported for saving (but  not  for
reading) files.

TPS format

There  are  keywords  and  parameters  for  the  number  of  landmarks,  the  number  of  background
curves,  and  for  the  number  of  points  in  each  curve.   The  coordinates  are  given  as  a  pair  of  x,y-
coordinates on each line with at  least  one blank separating them.  An ID code,  comment,  or numerical
codes may optionally  be given after special keywords.   See  the  example  given  below and  the  sample
files included with the program.  The data file consists  of two or more specimens to be analyzed (all  of
which must  all  be placed in the same file one after the other).   The must  all  have the same  number  of
landmarks.  If images are provided then the coordinates must be given in pixel units  in order to align the
landmarks  with  their  positions  on  the  images.   Images  must  be  provided  in  order  to  use  the  image
unwarping and image averaging features of the program.

The  following  keywords  are  defined:  LM,  LM3,  CURVES,  POINTS,  OUTLINES,  CHAIN,  RADII,
RADIIXY, IMAGE, ID, COMMENT, SCALE, and VARIABLES.  

 Note: the keywords do not need to be capitalized. It was done here just to make them stand out.

Initially,  an  "empty"  input  TPS  file  simply  provides  a  list  of  the  names  of  the  image  files.   For
example

LM=0

IMAGE=test1.tif

LM=0

IMAGE=test2.tif

After digitization the file is  expanded to include the  coordinates  of  the  landmarks  and,  optionally,
curves, comments, etc.   If the image is  enhanced it  can be stored under a new name and the TPS file
will  use the new file name (which can also be of a different  graphic  file format).   An  example  is  shown
below with explanatory comments to the right (not included the file).

LM=4 ß number of landmarks, label for specimen

10 25 ß x,y coordinates

1 50 "

5 22 "

22 45 "

CURVES=2 ß number of hand-drawn background curves

POINTS=4 ß number of points in first curve

0 20 ß x,y coordinates of first curve

5 25 "
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30 40 "

35 50 "

POINTS=4 ß number of points in second curve

50 50 ß x,y-coordinates of second curve

40 30 "

30 15 "

25 0 "

IMAGE=test1.BMP ß Name of file giving an updated image

ID=species1 ß any identification code

COMMENT=female ß a comment

SCALE=0.0054 ß scale factor to convert pixels to user units

OUTLINES=4 ß-2 outlines follow

CHAIN=20 ß stored as an 8-direction chain code with 20 steps

58 23 ß coordinates of the first point

0233344443665666554 ß chain coded outline

POINTS=5 ß next outline given using 5 coordinates

24 55 ß x,y coordinates of points around outline

33 75

45 65

32 45

22 31

RADIIXY=5 ß 5 radii as x,y coordinates

65 79

98 69

110 72

112 88

98 85

RADII=6 ß 6 radii at equal angles from centroid

62 78 100.286 78.889 ß start x,y and coordinates of centroid

 38.297 11.214  9.741 ß radii

24.739 10.258  7.464

Any missing landmarks will assigned the coordinates -1, -1. Note that at present the other programs
in the tps series will not recognize missing landmarks - though eventually they should.

  Note: the LM= keyword must be given first in the file even it is just "LM=0"..  The others can
be given in any order.

If the keyword RADII=n is used then the outline is stored as n equally-spaced radii from the centroid
of the outline. If the number of points is entered as a negative number then the radii are assumed to have
been captured in a clockwise direction. The next  line must  contain the x1,y1 coordinates  of the starting
point followed by the x,y coordinates of the centroid of the outline. Subsequent lines contain the n values
of the radii.

If the keyword RADIIXY=n is used then the n radii  are entered as  x,y  coordinate of their endpoints.
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Such an outline must be single-valued. Points will be deleted from the outline in order to achieve this.

The following image file formats are supported: BMP, GIF, JPG, PCX, PNG, and TIF.   Files  of each
type must use these codes as extensions to their file names.  

 The AVI and MOV multimedia files  are also supported by  tpsDig but  not  in a  tps  file.   You
must load the AVI or MOV files directly so that the program can extract individual frames to be digitized.

3.2 Sample data files

There are several sample data files on the distribution disk:

1. test.tps  is  a sample TPS file.   It  is  an initial file and is  intended  only  to  provide  a  list  of  the

image files to be processed.

2. There are two image files canadn0c.tif and canadn1.tif.  These are both images of the left

wing of female Aedes canadensis. 

These test files  can be used to experiment  with both image enhancement (both images are rather
dark low contrast images) and with recording of landmarks (try  using the branch points  of the veins  and
their points of intersection with the wing margin). 

3.3 Graphic file formats

The  following  types  of  standard  image  graphic  file  formats  are  supported:  TIFF  Bitmap
(TIF;TIFF;FAX;G3N;G3F),  CompuServe  Bitmap  (GIF),  JPEG  Bitmap  (JPG;JPEG;JPE),  PaintBrush
(PCX), Windows Bitmap (BMP;DIB;RLE),  Portable Network  Graphics  (PNG),  Windows Metafile (WMF),
Enhanced Windows Metafile (EMF),  Targa  Bitmap  (TGA;TARGA;VDA;ICB;VST;PIX),  Portable  Pixmap,
GrayMap,  BitMap  (PXM;PPM;PGM;PBM),  Wireless  Bitmap  (WBMP),  JPEG2000  (JP2),  JPEG2000
Code Stream (J2K;JPC;J2C), and Video for Windows (AVI).

Note: some TIF files use a special compression that this program may not be able to read.

3.4 Multimedia input window

This  window displays  frames from an AVI or MOV  file  and  transfers  selected  frames  to  the  main
tpsDig window.  
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The VCR type controls  enable one to move  forward  and  backward  through  a  file  to  select  the  desired
frame (the frame number will be displayed).  The progress bar shows the current position in the file.

 

The buttons above correspond to Play,  Pause,  Stop,  rewind to beginning,  backup  frames  (by  the  step
size),  advance frame  (by the step size), and move to the end of the file. The frame number displays  the
current frame number. The Skip by window allows one to choose the increment for advancing through the
file (may be useful when there are many frames).

Click  on the “Capture” button to transfer the current  image to the Main window.  Equivalently,  you
can click on the right arrow button in the main window to capture the currently  displayed frame.  Before
the  image  will  be  transferred  to  the  Main  window you  will  be  prompted  for  a  file  name  for  the  image
currently displayed in the main window if the “Query save image?” option is checked.

The name of  the  file  and  the  current  frame  number  will  be  stored  in  the  comments  field  when  a
frame is captured. This information will be saved with the TPS file.

 Note: make sure that  this  window is  fully  open and clear of any overlapping windows before you
click on the Capture button or else parts of these other windows may be included in the image.
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4 Support

4.1 Technical support

  For help with this program contact

F. James Rohlf, Department of Ecology and Evolution and Department
of Anthropology, Stony Brook University, Stony Brook, NY 11794-4364.
 

e-mail: f.james.rohlf@stonybrook.edu 

Announcements of bug fixes and other significant changes in the program will  be distributed via the
morphmet listserver at morphmet@morphometrics.org. You can also get  help with questions about

the  uses  of  this  software.   This  list  is  maintained  by  Dr.  Dennis  Slice  (e-mail:
dslice@morphometrics.org).  

4.2 Installing tpsDig2

On some computers there is a problem of where the INI file should be stored. On older software this was
usually in the same folder as the executable program file. A disadvantage of this is that on some networked
computer labs users are not permitted to write to such folders. The new standard location is in the user's
documents folder. This program will attempt to write the INI file there for all versions of Windows later than
Windows XP. Using the documents folder has the advantage that different users of the same computer will
have their own INI files with their own preferences. 

However, some computers are configured to not permit that even though they are using Windows 7 or 8. As
a work-around, one can add the -E parameter to the program when it is executed. It will then be forced to
use the program's folder as in XP. To do this one will have to edit the Windows shortcut icon for this
program. To do this right-click on the icon for tpsDig2 and select "Properties" from this context menu. Edit
the Target field by adding  -E to the end of the line (be sure to leave at least one blank space between
tpsdig2.exe and -E. The screenshot below shows an example (note that the path before tpsdig2.exe will be
different on your computer.

mailto:f.james.rohlf@stonybrook.edu
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4.3 Changes

The following are the more major changes have been made:

Version 2.28: Fixed the copy and  save  screen  operations  so  both  the  image  and  any annotations  are  also
included. Added option to  change the color of the "rubber band line" used for making measurements  (helpful
when working with dark images), and added an option to  select whether the sizes  of the landmark points  and
their labels should be in  image pixels  or screen pixels  (this  makes  a difference when working with  very large
images).

Version 2.26: Added option to  allow the current image zoom  factor to  be  applied  to  the  next  specimen.  Also
allowed the go to specimen window to accept up to 99999 specimens.

Version 2.25: Fixed several  problems  that occurred when no  specimens  had  been  loaded.  Added  option  to
"bee"  when  a  landmark  has  been  added.  Allowed  landmarks  to  be  added  after  a  curve  had  been
resampled.

Version  2.19:   Recompiled  using  Delphi  XE8  and  created  both  32  bit  and  64  bit  versions.  Some  relatively
minor changes were also made and the help file was also updated.

Version 2.12: Fixed problems  with  resampling  curves,  saving  changed  images,  and  setting  a  default  scale
factor.

Version 2.11: Fixed a problem in  recording measurements  to  the listing file. Added ability to  change the color
of the line used for measurements.

Version 2.09: Added ability to  resample curves  drawn with  the Curves  tool. A problem  with  setting  the  scale
factor was also fixed.

Version 2.08: A series  of minor updates  including: displaying in  the status  window  just  the  file  name  rather
than the full path name of the image and adding an option to  use a right-click to  toggle between edit
and landmark modes. 

Version  2.05:  Various  minor  problems  fixed.  Most  recent  was  to  improve  the  saving  of  measurements  as
“variables” that can be converted into a data matrix using the tpsUtil program.

Version  2.00:  Major  upgrade!  The  image  display and  manipulation  routines  were  replaced  which  required
many changes in the program. Set scale feature moved to the Image Tools window.

Version 1.40: Added option to  specify whether outlines  are to  be traced  in  a  clockwise  or  counter  clockwise
direction.

Version 1.34: Added areas in status panel to show total number of specimens in the file and the scale factor (if
any) for the current specimen.

Version  1.30:  Allows  outlining  and  viewing  of  thresholds  at  different  zoom  levels.  Fixed  a  problem  in  the
"template"  mode  of  digitizing  (when  the  second  point  moved  differed  a  lot  in  the  x-coordinate  the
landmarks did not align properly).

Version 1.28: Added computation of outline perimeter. Fixed some problems with measurement mode when a
scale was set.

Version 1.26: Added a linear measurement mode. Also fixed a problem when both outlines and landmarks are
recorded for an image.

Version 1.22: Added computation of enclosed area of curves  drawn when  in  curves  mode  (pencil  tool).  The
scale factor will  be applied if  it  has  been  defined.  Added  additional  ways  in  which  outlines  can  be
stored. Fixed a problem that could cause the image and the landmarks  to  be greatly out of alignment
in large image files. 
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Version 1.20: Allow zoom  level  to  remain the  same  after  image  operations  such  as  contrast  enhancement,
B&W invert, etc. Allow image cropping to  be performed while  image is  zoomed. Added a crop  mode
cursor.  Removed  an  unnecessary warning  message  about  data  not  having  been  saved.  Checks
landmark coordinates in input data file to make sure they are within the image.

Version 1.18: Fixed a number of small  problems  in  the program. Made corrections  and additions  to  help  file
and its index.

Version 1.17: Fixed several awkward problems  with  the user interface. The program  should now be easier to
use.  Added the following features: load file  from  the command line (and hence can be placed in  the
“send to” menu,  load  file  dropped  onto  form,  profile  plot  can  now  average  brightness  over  several
pixels, sample line width and color now shown on the Paint page of the Image toolbox.  When moving
from image to image the current zoom setting is now retained.

Version 1.16: Added support for input from  AVI and MOV multimedia files.  Added an  Append  TPS  file  menu
option and a paint mode in  which one can draw directly on an image. Added a profile  plot to  display
image brightness along a horizontal or vertical line.  Implemented WinHelp2000 style help file.

Version  1.15: Increased  the  maximum  number  of  landmarks  to  1000  (useful  for  some  non-morphometric
applications of the program).

Version  1.12: Added  ability to  compute  areas  corresponding  to  either  light  &  dark  pixels  or  to  the  region
enclosed by an outline.

Version 1.11: Added buttons to reflect an image from left to right or from  top to  bottom.  Added a menu item  to
allow the saving of the data using the NTS format. Added the use of the left and right arrow cursor keys
as equivalent to clicking on the left and right arrow buttons on the toolbar.  Fixed some bugs  resulting
from the conversion to a 32 bit program.

Version 1.10: Converted program to a 32 bit Windows 95/NT program.  Added an append data file option.

Version 1.08:  Several important small changes to eliminate problems produced by the inclusion of outlines  in
the previous version.

Version 1.07:  Major change is  the addition of automatic capture of image outlines   (either as  coordinates  or
as  chain  codes  ).  Added  Set_scale_window  for  each  image.  Added  a  "Clear  data"  item  in  the  file
menu.  This can be used to clear all information from all  specimens  so that you can start over.  Made
changes to prevent points  from  being saved whose coordinates  are not on the image.  Reorganized
the Image Toolbox window.  Changed x,y coordinates  displayed on the screen to  match the digitized
positions  even when the image is  zoomed (the y-coordinate is  somewhat arbitrary when there is  no
image). 

Version 1.06:  Various minor changes. 

Version 1.05: Added zooming of images.  Fixed some other problems with reading files.

Version 1.04: Added scroll  bars  so that larger images  could be used.  Fixed problem  with  reading an image
directly (rather than via a tps file).

Version 1.03: Alternative digitizing cursors  were added.  Print quality was  improved  and  a  choice  was  given
between  printing  just  the  image  or  the  image  as  seen  on  the  screen  with  the  landmarks.   The
maximum  numbers  of landmarks, curves, and points  along curves  was  increased.  The  method  for
handling error conditions was improved.

Version  1.01:  The  image  enhancement  operations  were  generalized  so  that  they would  work  with  graphic
adapters displaying more than 256 colors.  Other small  changes  were made to  the program  and this
help file.
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4.4 Updates

Updates  of  this  program  will  be  made  available  from  the  morphmet  directory  of  the  server  at

Life.Bio.SUNYSB.edu.   The  most  convenient  way  to  access  this  server  is  via  the  morphometrics

WWW  home  page  at  http://Life.Bio.SUNYSB.edu/morph/morph.html  (this  will  also  give

you a chance to see what other morphometric software is currently available).  

Note:  while not  always necessary,  it  is  good idea to uninstall  the  old  version  before  installing  the
new one. None of your data files will be lost or changed when uninstalling the program.

Announcements of bug fixes and other significant changes in the program will  be distributed via the
morphmet listserver at  morphmet@wfubmc.edu.   This  list  is  maintained  by  Dr.  Dennis  Slice  (e-mail:

dslice@morphometrics.org).  A  link  to  the  instructions  is  given  at  http://

www.morphometrics.org/home/morphmet. 

4.5 Credits

This software was developed by 

F. James Rohlf, Department of Ecology and Evolution and Department
of Anthropology, Stony Brook University, Stony Brook, NY 11794-
4364. 

e-mail: f.james.rohlf@stonybrook.edu

Its  development  was  supported  in  part  by  a  grant  (DEB  93-17572)  to  F.  James  Rohlf  from  the
Systematic  Biology  Program  of  the  National  Science  Foundation  and  by  a  grant  (IBN-9728160)  to  F.
James  Rohlf  and  Dennis  E.  Slice  from  the  Ecological  and  Evolutionary  Physiology  Program  of  the
National Science Foundation.

Dean Adams helped with some of the early  "crash testing"  of the program and proofing of the help
file.   Dennis  Slice  provided  some  technical  advice  and  Leslie  Marcus  gave  many  comments  of  the
operation of the program.  The comments  by  participants  at  the various morphometric  workshops  were
also  very  helpful.  Many  others  have  sent  me  suggestions  via  e-mail.  All  of  this  help  is  greatly
appreciated.  

To cite the use of this  software in a publication,  please list  it  in  your  bibliography  in  the  following
form (inserting, of course, the appropriate year and version number for your copy of the software):

Rohlf, F. J. 2005. tpsDig, digitize landmarks and outlines, version 2.05. Department of Ecology and
Evolution, State University of New York at Stony Brook.

One can cite the entire tps series of software as follows:

Rohlf FJ. 2015. The tps series of software. Hystrix, the Italian Journal of Mammalogy, 26:1-4.

The  paper can also be downloaded from the journal at:

http://www.italian-journal-of-mammalogy.it/

http://Life.Bio.SUNYSB.edu/morph/morph.html
mailto:f.james.rohlf@stonybrook.edu
http://www.italian-journal-of-mammalogy.it/
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4.6 Program limitations

At present the program has these limits:

Parameter Limit

Dimensions, k 2

Landmarks, p 1000

Background curves 25

Points in each curve 150

Points in each outline 10,000

Undo/redo stack 9

There is  no defined limit  to the number of specimens or  the  size  of  the  image  files,  but  at  some
point  the program will  run out  of memory.   While only  the image for  the  current  specimen  is  stored  in
memory, all coordinates are kept in memory until the file is saved. Except for the number of dimensions,
the limits can easily be changed.  Technical support is available if you have special requirements.

Another  limitation  is  due  to  the  resolution  and  color  depth  of  the  graphics  being  used.   Higher
resolution monitors  (e.g.,  1024x768) are more convenient  than  lower  resolutions.   This  software  is  not
designed to work on systems that cannot display  at  least  256 colors.   Images that  require many colors
or  many  shades  of  gray  often  do  not  display  properly  on  systems  set  to  use  just  256  colors.   The
problem is  that  even though tpsDig correctly  computes the transformed image,  Windows  may  redefine
some of the colors because it needs them to display other information on the screen.   The colors  of one
window may change when you highlight another window.  The solution is to set your graphics  adapter for
HiColor  (16  bit,  32K  colors)  or  TrueColor  (24  bit,  16M  colors)  modes.   Unfortunately,  these  require
additional RAM on the graphics adapter.  As a result you may be forced to use a lower resolution if you
have an older PC.

Images can be digitized directly from TWAIN compatible scanners.  Video sources compatible with
Microsoft TV in a Window can also be used.
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5 Glossary

5.1 Glossary

Chain code 

Contrast enhancement

IDH_Crop

Image smoothing 

Graphic file formats 

Laplacian enhancement

Rohlf (1990)

Rohlf and Bookstein (1990)

Spin control
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- C -
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Contents     4
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Convert color image to black & white     11
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Play     15, 27
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Credits     33

Crop image     11

Curves tool     9, 21

- D -
Data fi le formats     25

Delete program     7

Digitize mode     9

DLL     7

Drag and drop     5, 9

Draw curves mode     5

Drawing on the image     5, 9, 11

Duplicate curve points     21

- E -
Edit mode     9

E-mail     33

Enhanced Windows Metafile     27

Enhancement of images     11

Equalize enhancement     11, 16

- F -
Files     18, 25

nts     25

tps     25

Fit image to window     9

Fourier transformation     11, 16

Frame capture     15, 27

- G -
Gamma enhancement     11, 16

GIF     27

Glossary     36
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- H -
Help     30

HiColor     34

How to use this program     5, 9

- I -
Identification code     19

image enhancement     11
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Image enhancements     11, 16

Image enhancements window     16

Image fi le formats     27

Image smoothing     11, 16

Image tools window     11, 16, 20

Include image path     5

Information window     19

INI fi le problem     30

initial TPS fi le     5

Install      30

Introduction     4, 5

- J -
JPEG Bitmap     27

JPEG200     27

JPEG2000 Code Stream     27

- L -
Landmarks     5, 11, 34

LaPlacian image enhancement     11, 16

Linear distances     5, 9

Listing window     18

Listserver     33

- M -
Main menu     9

Main window     9, 15, 19, 20, 21, 27

Measurements     5, 9, 11, 16, 19

Missing landmarks     9, 25

Morphmet l istserver     30, 33

Morphmet@morphometrics.org     30

MOV files     15, 27, 27, 31

Multimedia input window     15, 27

multimedia video fi les     15, 27, 27

- N -
Negative of an image     11, 16

New versions     33

NTS fi les     25

NTSYSpc     25

- O -
Outline mode     9, 20

Outlines     5, 9, 11, 20, 21

Output l isting window     18

- P -
Paint mode     5, 11

PaintBrush     27

PCX     27

Pen color     11

Pen width     11

PNG     27

Pop-up menu     9, 20

Portable Network Graphics     27

Portable Pixmap    

BitMap     27

Profile mode     5

Profile window     19

Program limitations     34

Program modes     5

- R -
Redo operation     5, 11

Removing this program     7

Resize image     11, 16

Rohlf    

F. James     30

Rohlf@Life.Bio.SUNYSB.edu     30

Rotate image     11, 16

- S -
Sample data fi les     27

Scale factor     11, 18

Scanner     5

Semilandmarks     20, 21

Sharpen enhancement     11, 16

Size in window pixels     11

Sliding semilandmarks     20

Specimen information window     19

Specimen number     19

Status panel     20

Stony Brook morphometrics www site     33
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Suggestions     30

- T -
Targa Bitmap     27

Technical support     30, 34

Template mode     5

Threshold     11, 20

Thresholded image     5, 20

TIFF Bitmap     27

Tips    

equi-angular     20

Toolbar     9

Toolbox     5, 11, 20

TPS fi les     25

tpsDig2.INI     30

TpsUtil      5

TrueColor     34

TWAIN     34

TWAIN compatible scanners     34

- U -
undo button     11

Undo operation     5, 11

Undo/redo     34

Uninstall ing this program     7

units     11

Updates     31, 33

Using the curves tool     21

- V -
VARIABLES     5, 25

VCR     15, 27

Versions     31

Video for Windows     27

- W -
Windows Bitmap     27

Windows Metafile     27

Wireless Bitmap     27

- Y -
Y-coordinates    

landmarks     25
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